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Field Data Review Checklist_201110.docx 

AMS Field Data Review Checklist 
 

Time Period of Data: ___________________  to _____________________________ 
 
 Review Monthly Spreadsheets 

 
 Combine Spreadsheets to One File 

File: __________________________________________________________ 
 
 Field Cleaner 

Table: ___________________________________# of rows: _____________ 
Notes: ________________________________________________________ 

    
 Data Stacked in JMP 

Notes: _______________________________________________________ 
File (txt):______________________________________________________ 

 
yyyyDataQA.accdb 
Table: _________________________________# of records: _______________ 
 
 Duplicates Results without Depth 
 
 Crosstab Query: ____ 10   

    ____ 300 
    ____ other: ___________ 
 
 Duplicates for Results 

 
 Minimum of Date/Time Table: ________________________________ 

Total # of Sampling Events: __________ 
 

 Range of Results 
 
 Null Values 

 
 Comments Field 

 
 Results by Station 

 
 Random Sample Set- hard copy review  

____% of Data, ______# of Sampling Events, _____ # of Data Reviewed 
Files (txt): ____________________________________________________________ 
Non-recorded: _________ No Hard Copy: _________ Non-Matching: ____________ 
Notes: _______________________________________________________________ 
 
# of Records: ___________________ 
Other Comments: _______________________________________________________ 
 
Review Completed Date: ______________________ by: ________________________  
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AMS Field Data Review and Finalization 
 
Field data are entered by regional monitors into a regional monthly field data spreadsheet 
saved as yyyy_mm rRO.xlsx.  Regional spreadsheets are reviewed when received and 
identified concerns (such as values out of range or missing values) are sent back to the 
monitors for review and revision if necessary.  This review process pulls the regional 
monthly spreadsheets together and includes a more thorough review and check of the data.   
 
Monthly Spreadsheets  
(D:\AMS Everything Useful\Shared_AMS\Monthly AMS data summaries\yyyy) 
Combine regional sheets into one excel file per month. Save file as yyyy_mm.xlsx. 
  
Review monthly spreadsheet columns for missing data, typing errors, and miskeys.  
Common errors: 

Date:  Not within time period or missing; format: yyyymmdd 
Time:  Odd times such as early morning and late night or missing; format: hhmm 
Depth:  Very high numbers or missing 
Results:  Out of normal range for parameter  
Collector: Missing or wrong format (lastname firstinitial\lastname firstinitial) 

Make changes or add missing data.  This may require contacting monitors so they can check 
their records.  Also if you have received the corresponding lab sheets some data may be on 
them. 
Save file. 
 
Combine monthly spreadsheets for time period reviewing usually by quarter or 4P

 
Pmonth 

interval. Review quarterly spreadsheet again to make sure no data are missing. 
 
Save file as yyyy_month-month_Field.txt. (ex. 2013_Jan-Apr_Field.txt) 
 
Field Cleaner  
(D:\AMS Everything Useful\ Data Review) 
 
Import txt file into FieldCleanerB.accdb 
When importing change date/time fields to text fields and parameter fields to number- 
double.  You will want Access to add a primary key (autonumber).  
Name imported data table- tblyyyy_month-month_Field 
Once imported review table especially check date/time fields for correct format.   
 
Delete all RAMS Visit IDs (begin with R instead of V) from table 
 
Append recent Visit IDs to tblCurrentVID with query qappVisitIDsToCurrentVID.   
Open qappVisitIDsToCurrentVID in design view.   
Change the criteria to the month(s) and year associated with the Visit IDs to be added. 
!Run Query.  (Note: tblVisitID is linked from the Labsheet database) 
 
Open table tblToBeCleaned- Clear old data by highlighting all rows and selecting delete 
records. 
  
Append new field data to tblToBeCleaned 
Open design view of append query- qappAddTotblToBeCleaned. 
Add new table to query- Query Tools> Design Tab> Show Table. 
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Change Table source in query fields to new table and then remove old table from query.   
**Make sure you have changed all applicable columns or you may end up losing a 
column when you remove the old table. 

!Run query- should say appending ## of rows 
Check table tblToBeCleaned to make sure all data were included and no columns were lost. 
 
!Run macros mcrRunErrorChecks- enter start date, end date for time period of field data 
being reviewed. 
 
Check table tblErrors. 
Go through table to verify or change errors generated by macros.   
Main errors will be: Mismatch VID, Duplicate VID, Bad date/time, Duplicate Record, and 
Null Header Info. 
 
Append records back to main table by running- qappFixedErrorsToMainTable. 
 
Rerun mcrRunErrorChecks until satisfied that no more changes need to be made. 
 
Append records back to main table (tblToBeCleaned) each time after checking errors. 
 
Stacking Data in JMP 
(D:\AMS Everything Useful\ Data Review) 
 
Open JMP. 
Open Stack Field Data Script- StackFieldDataRev.JSL 
Run Script.   
You will be asked to select which table to open –select tblToBeCleaned. 
Check the final table that pops up especially the date/time field. 
Save file as yyyyField_month-month.txt. (ex. 2013Field_Jan-Apr.txt) 
 
**The SQL StackFieldDataRev should stack the field data for you but if not, here are the 
step by step directions. 
Open JMP 
Open Database Table- Connect to Access- find FieldCleanerB.accdb/tblToBeCleaned 
Check imported data especially dtmDateTime for blanks.  Delete extra date/time fields. 
 
Stack Tables  
Table>Stack 
UWithout depthU- stack columns= 20, 32, 35, 36, 45, 78, 1351 
 Stacked Data column= result 
 Source Label column= methodcode 
Click Stack 
Delete other method code columns 
 
Table>Stack  
UWith DepthU- stack columns= 10, 94, 300, 400, 480 
 Stacked Data Column= result 
 Source Label Column= methodcode 
Click Stack 
Delete other method code columns 
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Concatenate Results tables 
Tables>Concatenate 
Place both of the newly created tables into selected data table 
Click Concatenate 
Check newly created table with both “without depth” and “with depth”. 
 
Tables>Summary 
Group by results, statistics by N 
 
Select rows with “.” in result  
Delete selected rows from concatenated table. 
Save joined table as yyyyField_month-month.txt. (ex. 2013Field_Jan-Apr.txt) 
**This completes JMP process. 
 
Open text file in Excel to check for “.” in fields- Depth, Comments, Collector, etc.  This also 
keeps time in 24hr format when imported into Access. 
Save file. 
 
Data QA 
(D:\AMS Everything Useful\ Data Review\yyyy\yyyyDataQA.accdb) 
 
Import saved text file (yyyyField_month-month.txt) into database. 
Change the following fields to the listed data type: Date/Time- text, result/depth- double, 
methodcode- text 
Have Access add a primary key (autonumber). 
Name imported data table- tblyyyyField_month-month. (ex. tbl2013Field_Jan-Apr) 
 
Once imported review table especially check date/time fields for correct format.   
 
Add a field for Month (strMonth) to the table.  Save Table. 
Import updated tblCurrentVID from FieldCleanerB.accdb into database. 
Update the month column in data table through an update query using tblCurrentVID- 
qupMonthToData. 
 
Check for duplicate Results without Depth 
Create a find duplicates query that looks for duplicate visit ID and methodcode.   
Review duplicates- this will be for rows with depth. 
Change criteria in depth field to “is null” to check data without a depth. 
Review duplicates.  Make changes if necessary and delete duplicate rows due to depth 
profiles. 
 
Make Crosstab Query 
Row Heading- Station, methodcode 
Column Heading- strMonth 
Count(result) 
!Run query  
Change criteria in query to run for individual method codes 
Such as 300- Dissolved Oxygen,  10- Water Temperature 
  



AMS Appendix 4.2_AMS Field Data Review and Finalization_201312-Approved Page 4 
12/3/2013 

Check each query to see if the correct number of results show up for each month.  If there are 
discrepancies then verify there is no result for that station that month. Update missing or 
incorrect entries. 
 
Check for duplicate Results  
Create a find duplicates query that looks for duplicate visit ID, methodcode or duplicate visit 
ID, methodcode, depth, or duplicate visit ID, methocode, depth, result.   
Review and make necessary changes. 
 
Minimum of DateTime field (with Collector) 
Create a query with Visit ID, station, collector and dtmDateTime(min). 
Change query type to make-table query 
Name table- tblyyyyField_month-month_MinDTCol 
!Run Query- will ask if you want to append to new table- click yes. 
 
Update DateTime to Minimum DateTime (not always necessary) 
Make a backup copy of field data table- save as tblyyyyField_month-month_Copy. 
Create an update query with table tblyyyyField_month-month_MinDT and Field data table 
tblField_month-month.  Relate tables by strVisitID. 
Use DateTime field from Field data- update to minOfdtmDateTime field. 
!Run query 
 
Check Range of Result values- (This is done in basic check of monthly spreadsheets but 
another look does not hurt.) 
Create a query with max, min and count of results for each method code 
Columns- methodcode, displayname, result(count), result(min), result(max) 
Look for appropriate ranges of data, i.e. at or above detection limits, decimal places 
 
Check for null values 
Create a query with each column in the results table included.  In the criteria start on the first 
line for the first column and type “is null”.  Continue this for the other columns except the 
comments and depth fields but go down one line each time.  This should let you know if 
something is missing.   
 
Check Comments field 
Review comments- remove any unnecessary comments that should not carry on with the 
data. 
For all dissolved oxygen (300) readings with “LDO” comments, replace methocode 300 with 
LDO.  Remove LDO comments from all comments. 
 
Compare Results by Station to previous 5 years of data 
Create a min, max, count table for each station by methodcode based off the historical data 
(last 5 or more years).  (current table tblStationDataRanges_2008-2012) 
 
Compare min/max to new data. 
Open design view of qryCompareResultsToMinMaxField  
Add new data table (tblyyyyField_month-month) to query and change Table source to new 
table -then remove old table from query.  
Create relationships between tables to include stationcode=strStation and 
methodcode=methodcode.   
!Run Query 
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Review results that have a “!!!” in either the min or max column. Check with monitors for 
verification of results that don’t seem reasonable. 
 
Random Sample Set- Compare against field data hard copies 
Open the table tblyyyyField_month-month in JMP 
 
Tables> Summary 
Group by VisitID, station, datetime, collector 
Statistics- blank 
 
Create a random subset from the summary table 
Tables>Subset>Random sampling rate- enter a % (eg 0.05). Percentage will depend on 
number of results and feasibility to review.  Click- Link to original data table.  Click OK. 
Save subset table as Subset of ‘tblyyyyField_month-month’ RandomReview.txt 
 
Select all records in the subset table.  Go back to the original table tblyyyyField_month-
month in JMP and create a subset table from the selected rows.  
Tables>Subset>Selected rows 
Click- Link to original data table. 
Save subset table as Subset of ‘tblyyyyField_month-month’ RandomReviewData.txt.   
This table will include the individual data points related to the first random subset table. 
 
Split the data from the selected rows subset table for reviewing convenience. 
Tables>Split 
Split columns- result 
Split by- methodcode 
Group by- strVisitID, strStation, dtmDateTime, dblDepth 
Check “Keep all remaining columns” 
Click Ok. 
Rearrange order of methodcodes to match field data spreadsheet.  

- 94, 10, 300, 400, 20, 480, 45, 32, 36, 1351, 35, 78 
Save as Subset of ‘tblyyyyField_month-month’ RandomReviewData_Split.txt 
Open table in Excel and format for review purposes. 
 
Open file Subset of ‘tblyyyyField_month-month’ RandomReview.txt in Excel. 
Sort sampling events by regional office (by collector) and format table. 
Save file as Subset of tblyyyyField_month-month_#.xlsx. (ex. Subset of tbl2013Field_Jan-
Apr_60.xlsx) 
Send email to regional office monitors and request copies of the original hard copies for the 
selected sampling events.   
 
Review field data hard copies against file Subset of ‘tblyyyyField_month-month’ 
RandomReviewData_Split.txt.  Note any values that were not recorded on the hard copy 
but appear in the electronic version, no original hard copy could be found, and those where 
the hard copy version does not match the electronic version.   
 
Remove values that were not recorded on the hard copy or no hard copy is available. Revise 
values to hard copy versions for those that do not match.  
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AMS Lab Results Review Checklist 
 
Time Period of Data: _________________  to ___________________    Date: ________ 
 
 Export Data from LABWORKS- AMSPULL 

Sample Report Date: From _________________ to ______________________ 
Collection Date:  From _________________ to ______________________ 
# of Reports: ______________________ 
File (mdb): _______________________________________________________ 
# of Results: _______________________ 
 

yyyy_DataQA.accdb 
Table: _____________________________________  # of records: _____________ 

 
 Remove _Title_ Results:  #_________  # of records: _____________ 
 Remove Extra Records: # _________   # of records: _____________ 
 Review for Missing Reports  

 
 Agency, Location_Code, and Sample_Collector 

Notes: ____________________________________________________________ 
__________________________________________________________________ 
 

 Collection_Time 
Notes: ____________________________________________________________ 
__________________________________________________________________ 
 

 Sample-Depth 
Notes: ____________________________________________________________ 
__________________________________________________________________ 
 

 Matrix and Location_Type 
Notes: ____________________________________________________________ 
__________________________________________________________________ 
 

 FieldSample_ID (Visit IDs) 
Notes: ____________________________________________________________ 
__________________________________________________________________ 

 
 Analyte_Names 

Notes: ____________________________________________________________ 
__________________________________________________________________ 
 

 Combination_Result 
Notes: ____________________________________________________________ 
__________________________________________________________________ 
 

 Qualifiers 
Notes: ____________________________________________________________ 
__________________________________________________________________ 
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 Missing Results 
Notes: ____________________________________________________________ 
__________________________________________________________________ 

 
 Duplicate Results  

Notes: ____________________________________________________________ 
__________________________________________________________________ 

 
 Sample_Comments fields 

Notes: ____________________________________________________________ 
__________________________________________________________________ 
 

 Combine Sample_Comments 
Notes: ____________________________________________________________ 
__________________________________________________________________ 

 
 Range of Results 

Notes: ____________________________________________________________ 
__________________________________________________________________ 
 

 Results by Station 
Notes: ____________________________________________________________ 
__________________________________________________________________ 
 

 5 year Comparison 
Notes: ____________________________________________________________ 
__________________________________________________________________ 

 
 Random Sample Set: ______% of Data _____ # of Results 

Notes: ____________________________________________________________ 
__________________________________________________________________ 

 
 Flag QC samples with Hits and Corresponding stream samples 

Dissolved (DFB#): ______________ 
 

 
Other table/query names: ________________________________________________ 
 
# of records: _______________________ 
Other Comments: ________________________________________________________ 
_______________________________________________________________________ 
 
Reviewed Completed Date: _____________________ by: ________________________  
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AMS Lab Results Review and Finalization 
 
AMS data are reviewed every four months.  This provides time for the Lab to report 
analysis and enough data to compare results at each station.   
 
Lab data are exported from the Chemistry Lab’s LABWORKS database.  Access to 
LABWORKS is available online at 26TUhttps://sg.ncdenr.org/Citrix/XenApp/auth/login.aspxU26T.  
The Chemistry Lab has detailed instructions on accessing LABWORKS on their website- 
26Thttp://portal.ncdenr.org/web/wq/lab/staffinfo/labworks26T.   
 
Data are then reviewed for completeness, accuracy and format. 
 
LABWORKS Export 
 
Cross Reference Search 
From the Desktop, double-click Search and single-click Cross Reference.  In the Cross 
Reference Search window, select AMSPULL from the Available search routines and 
click OK.  For Sample Report date, enter the start and end reporting dates. (End date 
should be the day of or day before of when you are running the query in order to receive 
the most up-to-date reports.)  For Collection date, enter the start and end collection 
dates for the time period of data review.   Once the query has run, click Exit to close the 
window. 
 
Export Sample Data 
From the Desktop, double-click Reports and single-click Export Sample Data.  In the 
Data Export and Conversion to Electronic Formats window, select Cross Reference 
Search on the left toolbar. The AMSPULL search information should appear in the 
window as the last search.  Click View Selections and if a window pops up noting the 
selection criteria returned many samples, click Yes to continue querying data.   Once all 
the reports appear in the bottom window, click Enter Selection.     
 
The Export details window will appear.  The available formats should be 
ANDREARAMS in the top right window.  Click the Specify Output file button.  Select 
the location on your C: drive to export the file to.  (If you want to place in a folder, the 
name cannot have spaces in it.  Currently use LabworksExports folder.)  The file name 
can also be changed here.  Save the file as AMSyyyy_Mon-Mon_yyyymmdd.mdb (ex. 
AMS2012_Jan-Apr_20130729.mdb).   File will export as a Microsoft Access® database.  
Then click the Export Sample Data button.  The data will export which can take a while 
depending on the amount of results being exported. 
 
Once the data have completed exporting, open the database AMSyyyy_Mon-
Mon_yyyymmdd.mdb and review briefly to verify results and fields exported. 
 
Lab Data QA 
(D:\AMS Everything Useful\ Data Review\ yyyy Data Review \ yyyyDataQA.accdb) 
 
Import table FLATDATA from AMSyyyy_Month-Month_yyyymmdd.mdb into 
database.  Rename imported data table- tblyyyyLab_Mon-Mon (ex. tbl2013Lab_Jan-
Apr) 
 
Review imported table for correct number of records and format. 

https://sg.ncdenr.org/Citrix/XenApp/auth/login.aspx
http://portal.ncdenr.org/web/wq/lab/staffinfo/labworks
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Remove “_Title_” results 
Delete records with “_Title_” in the Combination_result field.  This appears for Color 
(PT & ADMI) and Wet_Icchrom.   
 
Review for non-AMS reports 
Delete records for Visit IDs not during review period, other non-AMS stations, etc.   
 
Check for Missing Reports by Event 
Event Query 
Create query with data table tblyyyyLab_Mon-Mon and tblCurrentVID.   
Create relationships between tables to include FieldSample_ID=strVisitID. 
Include fields Agency, Sample_ID, Location_Code, Collection_Date, Collection_Time, 
FieldSample_ID and strMonth. 
Totals ∑, group by for all fields. 
Save query as qryyyyyLab_Mon-Mon_Reports.   
 
Make Crosstab Query 
Create a crosstab query based on qryyyyyLab_Mon-Mon_Reports. 
Row Heading- Location_Code 
Column Heading- strMonth 
Calculation- Count(SampleID) 
!Run query and save as qryyyyyLab_Mon-Mon_Reports_Crosstab. 
 
Review Crosstab Query 
Review to see if correct number of lab reports and QC reports per station and month.  If 
any reports are missing, check if samples were collected or if data did not pull from 
Labworks and why.  If samples were not collected, note for future use in review process.  
If data did not pull from Labworks, check to see if Project Account Code in Labworks is 
equal to AMBIENT, date entered correctly (must be within range requested) or another 
issue.  Contact Lab for corrections.  Re-export data once Lab has made corrections. 
 
During review of crosstab results, revisions to dates or regions may be found.  Update 
data based on crosstab review.  
 
Check Agency, Location_Code and Sample_Collector 
Review the Agency, Location_Code and Sample_Collector fields to make sure the results 
match correctly and are spelled correctly.  Check reports and revise accordingly.   
 
Check Collection_Time 
Review Collection_Time field for 00:00 or times very early and very late.  Check reports 
and revise accordingly. 
 
Check Sample_Depth 
Review Sample_Depth field.  Stream samples should be at 0.1 or greater for photic zone 
samples and QC samples should be blank.  Check reports and revise accordingly.   
 
Check Matrix and Location_Type 
Review Matrix and Location_Type fields.  For Matrix, stream samples should be 
SURFACEWATER and QC samples should be BLANKWATER.  For Location_Type, 
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stream samples should be RIVER/STREAM, CANAL, ESTUARY, RESERVOIR or 
LAKE depending on location and filter blanks (DFB#) should be FILTER BLANK.   
 
Check FieldSample_ID (Visit IDs) 
Review FieldSample_ID field.  Stream samples should have a Fieldsample_ID (format 
V######, ex. V02345) and QC should be blank.  Check reports and revise accordingly.   
 
Create a “Find Unmatched Query” with the query wizard to compare FieldSample_ID 
(tblyyyyLab_Month-Month) and strVisitID (tblCurrentVID).  Review any unmatched 
Visit IDs.  QC samples will not have a Visit ID and should be blank. 
 
Check Analyte Names  
Review Analyte_Name field for misspellings.  Contact lab if necessary and revise 
accordingly.   
 
Check Combination_Result 
Review Combination_Result field. If a qualifier (X#, Z#) is reported as a result, move to 
the qualifier field.   
 
Check Qualifier 
Review Qualifier field.  Remove any spaces and add commas to separate individual 
qualifiers if more than one reported.  May need to increase qualifier field size to 10. 
 
Check for Missing Samples 
Create a crosstab query to check for missing samples.   
Row Heading- Location_Code 
Column Heading- Analyte_Name 
Calculation- Count(Combination_Result) 
Copy and Paste Special query results to Excel (This can be done in Access but Excel 
provides more formatting options to make it easier to review). 
Save excel file as AMS_yyyyLab_Mon-Mon_Crosstab. 
 
Review to see if correct number of results per station and analysis.  If any results are 
missing, check if samples were collected or if samples were incorrectly reported (total vs. 
dissolved).  If samples were not collected, note for future use in review process.   If 
samples were incorrectly reported, contact Lab for corrections.  Re-export data once Lab 
has made corrections. 
 
Check for Duplicate Results  
Create a “Find duplicates query” from tblyyyyLab_Mon-Mon that looks for duplicate 
SampleID, Location_Code, Analysis_Code, Analyte_Name, and Combination_Result.   
 
Check Sample_Comments-line_# fields 
Review Sample_Comments_Line_# fields. Labworks export format ANDREARAMS 
pulls the first 15 Sample_Comments_Line_# fields.  More can be added, if necessary.  
Remove any sample comments that do not relate to an analyte/analysis.  This may require 
deleting some sample comments and keeping others. If all sample comments are removed 
then the Sample_Comments field should be updated to “N”.  The sample comments 
should also be checked for spelling and extra spaces.   
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Combining Sample Comments 
Add Sample_Comments_Memo  and Results_Comments_Memo fields to 
tblyyyyLab_Mon_Mon.  Data type= Memo and placed at end of field list. 
 
Update Sample_Comments_Memo with all the Sample_Comments_Line_# fields with 
comments in them.  Create an Update query with the Sample_Comments_Memo and all 
the needed Sample_Comments_Line_# fields.   
Sample_Comments_Memo: update to [Sample_Comments_Line_1] & “ ” & 
[Sample_Comments_Line_2] & “ ” &  [Sample_Comments_Line_3] & “ ” & 
[Sample_Comments_Line_4] & “ ” &  [Sample_Comments_Line_5] &…….  
Criteria- Line 1- is not null and not “”; Line 2- is not null and not “”; Line 3- is not null 
and not “”;…… 
!Run Query 
 
Check Sample_Comments_Memo for format (add spaces) and remove any extras that 
were missed in the earlier review.  Spell check the comments and correct.   
 
Check Range of Combination_Result values 
Open table tblyyyyLab_Mon-Mon in JMP.  Change Combination_Result field to 
numeric, continuous.  Create a Summary table with Min, 25%, 50%, 75%, and max for 
Combination_Result and group by Analysis_Code and Analyte_Name.   
Save as a text file.   
Open in Excel and Review.  Look for appropriate ranges of results, i.e. at or above 
detection limits, decimal places. 
 
Check Combination_Result by Location_Code and Analyte_Name 
Open table tblyyyyLab_Mon-Mon in JMP.  Change Combination_Result field to 
numeric, continuous. 
Analyze- fit y by x; x=Location_Code, y=Combination_Result, group by = 
Analyte_Name, Agency 
Review graphs looking for outliers.   
 
Check Results by Station to previous 5 years of data 
Create a min, max, count table for each station by methodcode based off the historical 
data (last 5 or more years). (current table: tblStationDataRanges_2008-2012) 
 
Open design view of qryMethodCodeAddition 
Add new data table (tblyyyyLab_Mon-Mon) to query and change Table source to new 
table -then remove old table from query. 
Create relationship between tables for Analyte_Name (tblyyyyLab_Mon-Mon) = 
Analyte_Name (refCharacteristicTranslation) and include all records from 
tblyyyyLab_Mon-Mon and only matching for refCharacteristicTranslation.   
Check the query table to make sure all Analyte_Names are included in table 
refCharacteristicTranslation. 
Change query to a make-table query with the new table name= tblyyyyLab_Mon-
Mon_methodcode.   
!Run query.  
 
Open table tblyyyyLab_Mon-Mon_methodcode in design view. Change 
Combination_Result to number-double.  Save table. 
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Compare min/max to new data. 
Open design view of qryCompareResultsToMinMaxLab-Labworks  
Add new data table (tblyyyyLab_month-month_methodcode) to query and change 
table source to new table -then remove old table from query. 
Create relationships between tables to include Location_Code=stationcode and 
methodcode=methodcode.   
!Run query. 
 
Review results that have a “!!!” in either the min or max column against the lab sheets to 
check for typo’s.  Correct typo’s and check with lab for other outrageous results that 
don’t seem reasonable. 
 
Check Random Sample Set of Combination_Result 
Open table tblyyyyLab_Mon-Mon in JMP.   
Table>Subset>Random sample- pick a % (eg 0.05 or 0.025). Percentage will depend on 
number of results and feasibility to review. 
Save new table as a text file- Subset of ‘tblyyyyLab_Mon-Mon’.txt. (ex. Subset of 
‘tbl2013Lab_Jan-Apr’.txt) 
Open text file in Excel and format.  Save a .xlsx file and print. 
Check results against hard copy lab reports to make sure database matches the lab 
reports. 
Correct any changes. 
 
Flag QC samples with Hits and corresponding stream samples 
Add QC_Flag field to tblyyyyLab_Mon_Mon.  Data type= Yes/No and placed after 
Secondary_Result and before Sample_Collector. Save. 
 
Update table source in query qryEBhits with table tblyyyyLab_Mon-Mon.  Run query 
to see QC Samples with hits.   
 
Use query qryReviewID to view and flag samples with related QC hits.  Flag QC sample 
and stream sample as follows: 
DFB# flagged if analyte ≥ PQL (not U) or X# or Z# qualifier. 
 
Also flag stream sample results if no QC sample was collected.  Report and Analyte 
crosstab reviews will help with identifying missing QC samples.   
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AMS Field and Lab Data into Results Database Checklist 
 
Time Period of Data: ______________________  to ________________________ 
 
Field Data Table: _____________________________ # of records: ____________ 
Lab Data Table: ______________________________ # of records: ____________ 

 
yyyyDataQA.accdb 
 Compare DateTime for Results 

 Notes: ______________________________________________________ 
  ______________________________________________________ 

 
 Combine Field and Lab Data 

Table: _________________________________ # of records: ___________ 
 
 Check Changes in Data due to JMP 

 
 Calibration Sheet review 

File: _________________________________________________________ 
# of sampling days: __________________ 
# of missing sheets: _____________# of records removed: _____________ 

 Table:________________________________________________________ 
 
# of records:___________________ 

 
AMSData13_be.accdb 
 Backup Results Table 

Notes: _________________________________________________________ 
Table: __________________________________________________________ 

 
 Link Combined Field And Lab Data Table 

 
 Append Data into Main Results Table 

Original # of results:    _____________________ 
# of results Added: Total:  _____________________ 

NCAMBNT: _____________________ 
NCSPST: _____________________ 

Final # of results:      _____________________ 
 
Other Comments: ______________________________________________________ 
 
Review Completed Date: ____________________ by: _________________________  
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AMS Field and Lab Data to Main Results Database 
 
Data QA 
(D:\AMS Everything Useful\ Data Review\yyyy\yyyyData QA.accdb) 
 
Compare datetime for both lab and field data 
Open query qryCompareDateTime_Lab-Field in design view. 
Add both the new lab and field data tables to query- Query Tools>Design 
Tab>ShowTable. 
Create relationships between the tables to include strStation(Field) = Station(Lab), 
strVisitID(Field) = VisitID(Lab), and Station(Lab) = strStoretNumb(tblStation). 
Change table sources in query fields to match new tables and then remove old tables from 
query.   

**Make sure you have changed all applicable columns or you may end up losing 
a column when you remove the old tables. 

!Run query.  This query will let you know which date times do not match in both the field 
and lab data. 
 
Check all “!!!” entries for the correct values. This will require reviewing field data and 
lab sheets. 
Common errors are: 

Wrong date on lab sheet- can look at receiving date if there is a question 
Wrong date in field data- monitor sampled on different date than originally 
planned or miskeyed data. 

Contact monitor if necessary for confirmation of revisions.  Correct any mistakes.  
 
Combine Field and Lab data 
Copy Lab data table and change name of table to tblyyyy_month-month (ex. 
tbl2012_Jan-Apr). 
 
Create an append query to append the field data (tblyyyyField_month-month) to table 
tblyyyy_month-month. The field types will need to match in both tables. 
!Run query- will ask if you want to append to table- click yes. 
 
Round depth field 
JMP likes to change the number of decimal points for depth and results- may need to 
round fields- Create Update query- update depth field to round([depth_m],1) 
!Run query 
 
Calibration Sheet Review 
Open query qrySamplingDatesByRegion in design view. 
Add table tblyyyy_month-month to query- Query Tools>Design Tab>ShowTable. 
Create relationships between the tables to include Station(combined) = 
strStoretNumb(tblStation). 
Change table sources in query fields to match new table and then remove old table from 
query.   

**Make sure you have changed all applicable columns or you may end up losing 
a column when you remove the old tables. 

!Run query.  This will provide a list sampling dates by collector for the time period 
reviewed. 
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Copy table to Excel and paste special as text. 
Save as yyyy_month-month_CalibrationCompare.xlsx (ex. 2012_Jan-
Apr_CalibrationCompare.xlsx). 
 
Open Calibration database (R:\AMS\AMS Calibration Log) and query 
qryUniqueRegionCollectorDateMeter.  Enter start date and end date for time period of 
data review. 
 
Copy and paste table into yyyy_month-month_CalibrationCompare.xlsx in columns 
next to the values from yyyyData QA.accdb.  Go through spreadsheet and match entries.  
Add spaces to the appropriate fields when matching values are not included.  This could 
be due to no calibration sheet for a sampling event or no AMS sampling event for a 
calibration sheet since the calibration database has all sampling events including AMS.    
 
Review rows with blanks especially sampling events without calibration sheets.  Contact 
regional monitors about missing calibration sheets and if available, add information to 
database and spreadsheet.   
 
Once all available calibration sheets are entered, review the reports in the Calibration 
database for DO, specific conductance, and pH.   
When post-sampling checks were not completed, not within QC accept criteria, or no 
calibration sheet is available, then data for associated dates, stations and parameters are 
flagged in the comments field of tblyyyy_month-month with “to be removed”.    
 
Review hard copy calibration sheets to verify failure. 
 
Create a make table query with tblyyyy_month-month.  Pull all fields and under the 
Comments field add the criteria “to be removed*”.  
Name the new table – tblyyyy_month-month_ToBeRemoved. 
!Run query. 
 
Once the data have been added to the new table, change the query type to delete query. 
!Run query to remove associated data from table tblyyyy_month-month.   
 
 
UAMS Database 
(D:\AMS Everything Useful\ AMS data\AMSData13.accdb 
 
Backup Main Results Table 
Copy the main Results table- tblAMSResults 
Save table. (example- tblAMSResultspre2011JFMAData) 
 
Import Combined Table 
Export combined table tblyyyy_month-month as a tab delimited text file from 
yyyyDataQA.accdb.  
 
Import combined Field and Lab data table (tblyyyy_month-month) to database. 
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Append New Data to tblAMSResults 
Create an append query- use the combined Field and Lab data table and tblCurrentVID.  
May need to import or link tblCurrentVID to this database also. Connect the tables by 
Visit ID and join properties to include all rows from combined Field and Lab data table 
and only those in tblCurrentVID. 
 
For agencycode column- the agency field will need to be created and assigned to 
“NCAMBNT” or “NCSPST” depending on the criteria (see below).  Add station number, 
DateTime, depth, methodcode, result, remark, collector, comment fields from combined 
field and lab data table.  Match to fields in tblResults 
 
From tblCurrentVID- add lngSamplingCode. 
 
UNCAMBNT criteria 
Currently all data except Chronic Special Studies 
 
 
UNCSPST criteria (Chronic Special Studies) 
Station-  
VisitID- is null 
 
!Run query 
 
Check tblAMSResults for new results and correct formatting.   
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